
Q.1 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. IE – NG

2. QM – VO

3. GC – LF

4. DZ – IB

Q.2 If ‘A’ stands for ‘÷’, ‘B’ stands for ‘×’, ‘C’ stands for ‘+’ and ‘D’ stands for ‘−’, then what
will come in place of the question mark (?) in the following equation?

(46 B 8) A 16 C 15 B 3 D 27 =?
Ans 1. 41

2. 68

3. 29

4. 52

Q.3 A vendor sells oranges at ₹44 each and incurs a loss of 78%. If he wants to make a
profit of 78%, at what price (in ₹) should he sell each orange?

Ans 1. 356

2. 358

3. 355

4. 354

Q.4 Which bank has officially partnered with Sunrisers Hyderabad (SRH) as its exclusive
banking partner in March 2025?

Ans 1. Axis Bank

2. HDFC Bank

3. City Union Bank

4. ICICI Bank

Q.5 At what rate of interest per annum will a sum of ₹15,625 amount to ₹19,683 in 1 year and
6 months, if the interest is compounded half-yearly?

Ans 1. 8%

2. 20%

3. 16%

4. 19%
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Q.6 In a certain code language, ‘FISH’ is coded as ‘6147’ and ‘SALE’ is coded as ‘9512’. What
is the code for ‘S’ in the given code language?

Ans 1. 5

2. 4

3. 9

4. 1

Q.7 A local train without stoppages runs at an average speed of 70 km/hr, and with
stoppages, at an average speed of 30 km/hr. What is the total time (in hours) taken by
the local train for stoppages on a route of length 630 km?

Ans 1. 19

2. 12

3. 10

4. 8

Q.8 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) 7 @ £ 1 @ 7 # * 8 7 8 6 5 3 8 4 € # £ 9 1 £ (Right)

How many such symbols are there each of which is immediately preceded by a number
and also immediately followed by a number?

Ans 1. 1

2. 3

3. 2

4. 0

Q.9 Which of the following ratios is greatest?
Ans 1. 17 : 42

2. 20 : 36

3. 21 : 45

4. 25 : 50

Q.10

Ans 1. 

2. 

3. 

4. 

Q.11 If the median of a data is 45.98 less than its mode, then the median of the data exceeds
its mean by _____. (Use empirical formula)

Ans 1. 25.13

2. 22.99

3. 21.05

4. 26.54

Q.12 Which of the following states recorded the highest Schedule Tribes (ST) sex ratio in
2011, as per the Census of India data?

Ans 1. Tamil Nadu

2. Goa

3. Mizoram

4. Arunachal Pradesh
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Q.13

Ans 1. 24 hours

2. 7 hours

3. 17 hours

4. 10 hours

Q.14 Which of the following is NOT located in the Andaman group?
Ans 1. Havelock

2. Barren

3. Neil

4. Minicoy

Q.15 In which of the following countries did the United Nations Biodiversity Convention 2024
(COP16) conclude in February 2025?

Ans 1. Germany

2. France

3. Italy

4. Colombia

Q.16 Which shortcut key combination is used to insert a hyperlink in MS PowerPoint 365?
Ans 1. Alt + X

2. Ctrl + Shift + X

3. Ctrl + N

4. Ctrl + K

Q.17 Anuj starts from Point A and drives 12 km towards East. He then takes a right turn,
drives 8 km, turns right and drives 14 km. He then takes a right turn and drives 11 km.
He takes a final right turn, drives 2 km and stops at Point P. How far (shortest distance)
and towards which direction should he drive in order to reach Point A again? (All turns
are 90° turns only, unless specified.)

Ans 1. 2 km to the south

2. 4 km to the south

3. 1 km to the south

4. 3 km to the south

Q.18 ​​​​​​​​F is the husband of G. G is the mother of H. H is the husband of I. I is the mother of J.
How is F related to J?

Ans 1. Father's brother

2. Father's father

3. ​Mother's brother

4. Mother's father

Q.19 In MS Word, if you want to duplicate a selected text without removing it from its original
location, which set of commands should you use?

Ans 1. Delete → Undo

2. Select → Move

3. Copy → Paste

4. Cut → Paste
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Q.20 What is the dimensional formula of pressure?
Ans 1. [M L T⁻²]

2. [M L⁻² T⁻²]

3. [M L² T⁻²]

4. [M L⁻¹ T⁻²]

Q.21 ‘Pradeshtris’ word is used for which officers during the Mauryan Empire?
Ans 1. Chief minister

2. Commander of army

3. Officers responsible for suppression of criminals

4. Judges

Q.22 I, J, K, L, M and Y live on six different floors of the same building. The lowermost floor in
the building is numbered 1, the floor above it, number 2 and so on, till the topmost floor
is numbered 6. Only L lives above Y. I lives on some floor below J. Only M lives below K.
How many people live between J and M?

Ans 1. Four

2. One

3. Three

4. Two

Q.23 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
All cows are emu.
All emus are ostrich.
Some ostriches are duck.

Conclusions:
(I) Some ducks are cows.
(II) All ostriches are cows.

Ans 1. Only conclusion (I) follows

2. Only conclusion (II) follows

3. Both conclusions (I) and (II) follow

4. Neither conclusion (I) nor conclusion (II) follows

Q.24 In Windows-based systems, which Alt key combination is most likely to display the
contextual control menu of the active window, especially when the title bar is
inaccessible?

Ans 1. Alt + F4

2. Alt + Del

3. Alt + Space

4. Alt + F10

Q.25 Seven friends, A, B, C, D, P, Q and R, are sitting in a straight line facing north. Only two
people sit to the left of R. Only three people sit between R and P. Only one person sits
between P and A. D sits to the immediate left of Q. B is not an immediate neighbour of P.
How many people sit to the right of C?

Ans 1. One

2. Two

3. Four

4. Three
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Q.26 In MS Word 365, which feature allows users to set specific spacing before and after
paragraphs to control the vertical space between paragraphs and improve document
readability?

Ans 1. Indentation

2. Page Layout

3. Line Spacing

4. Paragraph Spacing

Q.27 The speed of a boat in still water is 9 km/hr and the speed of the stream is 5 km/hr. A
man rows to a place at a distance of 75.6 km and comes back to the starting point. Find
the total time (in hours) taken by him.

Ans 1. 24.3

2. 26.6

3. 19.3

4. 20.8

Q.28 Vinod starts from point A and drives 8 km towards the west. He then takes a left turn,
drives 6 km, turns left and drives 12 km. He then takes a left turn and drives 11 km. He
takes a final left turn, drives 4 km and stops at point P. How far (shortest distance) and
towards which direction should he drive in order to reach point A again? (All turns are
90-degree turns only unless specified.)

Ans 1. 5 km to the south

2. 6 km to the south

3. 5 km to the north

4. 6 km to the north

Q.29 Seven people, I, J, K, L, O, P and Q are sitting in a row, facing north. Only two people sit
to the right of I. Only two people sit between I and O. Only two people sit between J and
P. P sits to the immediate left of I. Q sits to the immediate right of L. Who sits at third
position from the left end of the line?

Ans 1. I

2. O

3. Q

4. K

Q.30

Ans 1. 13

2. 17

3. 3

4. 18

Q.31

Ans 1. 

2. 

3. 

4. 
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Q.32 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. WC – BY

2. LR – QM

3. HN – MI

4. BH – GC

Q.33 The value of 596 × 604 is:
Ans 1. 364199

2. 366958

3. 356822

4. 359984

Q.34 Bholanath Singh was the leader of which of the following revolts?
Ans 1. Farazi Movement

2. Wahabi Movement

3. Tamar Revolt

4. Santhal Revolt

Q.35 OJ 9 is related to QM -8 in a certain way. In the same way, JK 14 is related to LN
-3. To which of the given options is VP 1 related, following the same logic?

Ans 1. XT -16

2. YS -14

3. XS -16

4. YT -16

Q.36 Income of Amit in 2019 was ₹22,000. He gets an increment of 20% every year. What was
his income (in ₹) in 2021?

Ans 1. 26,400

2. 30,800

3. 31,680

4. 22,000

Q.37 What major tax reform was introduced by the 101st Amendment Act, 2016?
Ans 1. Goods and Services Tax (GST)

2. Income Tax

3. Wealth Tax

4. Excise Duty
           

Q.38 What should come in place of the question mark (?) in the given series?

13 8 24 19 57 52 156 ?
Ans 1. 155

2. 151

3. 140

4. 169
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Q.39 How many rural households were graded based on deprivation criteria, as per Socio
Economic and Caste Census (SECC) that was concluded by the Ministry of Rural
Development in March, 2016?

Ans 1. 6.72 crore

2. 7.72 crore

3. 8.72 crore

4. 9.72 crore

Q.40 When appointing Governors of States and Lieutenant Governors of Union Territories,
the President of India acts on the advice of which body?

Ans 1. The Supreme Court of India

2. The Union Council of ministers

3. The State Legislatures

4. The Election Commission

Q.41 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) 5 $ 6 @ 3 * 6 4 & $ 2 9 5 9 € £ 7 8 # 1 & 2 (Right)

How many such numbers are there each of which is immediately preceded by a symbol
and also immediately followed by a symbol?

Ans 1. 4

2. 2

3. 3

4. 5

Q.42 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?
# : OLR :: LIO : %

Ans 1. # = PKI, % = IMJ

2. # = ROU, % = IFL

3. # = RPO, % = MKP

4. # = YTU, % = LKJ

Q.43 Who was honoured with the title 'Assam Kesari' for his courageous role in the Indian
freedom movement?

Ans 1. Ambikagiri Raichoudhury

2. Chandraprabha Saikiani

3. Tarun Ram Phukan

4. Gopinath Bordoloi

Q.44 The ratio of the lengths of two corresponding sides of two similar triangles is 10 : 9. The
ratio of the areas of these two triangles, in the order mentioned, is:

Ans 1. 10√10 : 9

2. 101 : 82

3. 10 : 9

4. 100 : 81
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Q.45 What should come in place of the question mark (?) in the given series?

842 840 836 830 822 ?
Ans 1. 812

2. 814

3. 808

4. 810

Q.46 Who among the following is NOT eligible for the subsidy under the PMAY-U 2.0 scheme
launched in 2024?

Ans 1. Individuals with annual income up to ₹6 lakh

2. Middle Income Groups (MIG) having an annual income of up to ₹9 lakh per year

3. Families given housing by any government scheme in the past 20 years

4. Individuals from Economically Weaker Sections (EWSs)

Q.47 On simple interest, a certain sum of money amounts to ₹1,750 in 2 years and to ₹3,250
in 4 years. Find the rate of interest per annum.

Ans 1. 302%

2. 299%

3. 300%

4. 301%

Q.48 What will come in place of the question mark (?) in the following equation, if ‘+’ and ‘−’
are interchanged and ‘×’ and ‘÷’ are interchanged?

76 ÷ 9 + 818 × 2 − 93 = ?
Ans 1. 398

2. 378

3. 388

4. 368

Q.49 QQ 3 is related to NU -1 in a certain way. In the same way, OK 11 is related to LO 7. To
which of the given options is PL -2 related, following the same logic?

Ans 1. NP -4

2. NQ -6

3. MQ -4

4. MP -6

Q.50 In MS Word 2019, which of the following features can you use to change the page
orientation of your document?

Ans 1. Page Layout → Orientation

2. Review → Spelling & Grammar

3. Insert → Page Number

4. View → Print Layout

Q.51 Two taps can fill a cistern in 3 hours and 18 hours, respectively. A third tap can empty it
in 72 hours. How long (in hours) will it take to fill three-fourth of the empty cistern, if all
of them are opened together?

Ans 1. 4

2. 8

3. 6

4. 2
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Q.52 In which type of musical instruments, sound is produced by blowing air into a hollow
column?

Ans 1. Sushira Vadya

2. Tata Vadya

3. Avanaddha Vadya

4. Ghana Vadya

Q.53 Each of the digits in the number 691478325 is arranged in ascending order from left to
right. What will be the sum of the digits that are third from the left and second from the
right in the new number thus formed?

Ans 1. 10

2. 9

3. 12

4. 11

Q.54 If α, β and γ are the roots of the equation 6x3 − 11x2 + 6x − 1 = 0, find Σα2βγ.
Ans

1. 

2. 

3. 

4. 

Q.55 Anti-dumping and anti-subsidies & countervailing measures in India are administered
by which Ministry?

Ans 1. Ministry of Home Affairs

2. Ministry of Finance

3. Ministry of External Affairs

4. Ministry of Commerce and Industry

Q.56 Let ABC and DEF be two triangles such that ∠A = ∠D = 40° and AB = DE. What is the
condition required to be met such that ABC and DEF are similar triangles?

Ans 1. ∠B = ∠F

2. BC = EF

3. ∠C = ∠F

4. ∠B = ∠D

Q.57 If 1 is added to each odd digit and 1 is subtracted from each even digit in the number
8631247, what will be the sum of the digits that are third from the left and first from the
right?

Ans 1. 8

2. 9

3. 11

4. 12

Q.58 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?

XDO BBQ FZS JXU ?
Ans 1. LWX

2. MUX

3. NVW

4. OWV
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Q.59 Which Indian state/Union territory had the highest urbanised population, as per the
Census 2011?

Ans 1. Goa

2. Maharashtra

3. Tamil Nadu

4. Delhi

Q.60 7 times the present age of X is 6 years less than 2 times the present age of Y. At present,
P is 7 times as old as X, and Y is 6 years younger than Q. If P is 70 years older than Q,
then the present age (in years) of Y is:

Ans 1. 73

2. 75

3. 82

4. 78

Q.61 What is the advantage of keeping food in an airtight container?
Ans 1. It slows down oxidation.

2. It enhances the taste of the food.

3. It promotes anaerobic bacterial growth.

4. It changes the colour of the food.

Q.62 The award (decision) made by the Lok Adalats is deemed to be a decree of a civil court
and is final and binding on all parties because:

Ans 1. An appeal can be filed in the High Court

2. A review petition can be filed

3. No appeal is permissible

4. An appeal can be filed in the Supreme Court

Q.63 Which of the following countries experienced widespread protests in May 2025 due to
the government's decision to dissolve all political parties and extend the presidential
term?

Ans 1. Niger

2. Sudan

3. Mali

4. Chad

Q.64 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?
TMP RKN PIL NGJ ?

Ans 1. LEG

2. LFH

3. LFG

4. LEH

Q.65 The median of the observations 34, 58, 98, 42, 83, 62, 12, 11, 87, 75 and 15 is:
Ans 1. 75

2. 58

3. 42

4. 62
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Q.66 The average of eight numbers is 14. The average of five of these numbers is 14. The
average of the remaining three numbers is:

Ans 1. 13

2. 16

3. 14

4. 15

Q.67 Find a single discount (rounded up to two decimal places) equal to three consecutive
discounts of 3%, 27% and 23%.

Ans 1. 43.03%

2. 45.34%

3. 45.73%

4. 45.48%

Q.68 In a certain code language, ‘MUST’ is coded as ‘4268’ and ‘SALE’ is coded as ‘3527’.
What is the code for ‘S’ in the given code language?

Ans 1. 7

2. 2

3. 3

4. 6

Q.69 Which of the following numbers is divisible by 87?
Ans 1. 7221

2. 7099

3. 6712

4. 7741

Q.70 Which of the following statements about the December 2024 appointments to the
National Human Rights Commission (NHRC) is INCORRECT?

Ans 1. Justice (Dr.) Bidyut Ranjan Sarangi joined NHRC as a Member.

2. Justice V Ramasubramanian was appointed as the Chairperson of NHRC.

3. The appointments were made by the President of India in December 2024.

4. Shri Priyank Kanoongo was appointed as the Secretary General of NHRC.

Q.71 Manish ranked 18th from the top and 49th from the bottom in his class. How many
students are there in his class?

Ans 1. 65

2. 67

3. 66

4. 64

Q.72 Which Fundamental Right was introduced by the 86th Constitutional Amendment Act of
2002 specifically for children?

Ans 1. Right to free electricity

2. Right to vote

3. Right to travel abroad

4. Right of children to free and compulsory education
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Q.73 Where can people of Indian origin living abroad apply for Indian citizenship under
Article 8?

Ans 1. Indian Embassy at their country of living

2. State government office

3. Indian Embassy in Delhi only

4. Supreme Court

Q.74 Who among the following has become the 11th Chairman of Securities and Exchange
Board of India in February 2025?

Ans 1. Ajay Seth

2. Dr. Mayank Sharma

3. Manan Kumar Mishra

4. Tuhin Kanta Pandey

Q.75 Three numbers are in the ratio 2 : 14 : 3, and their LCM is 4116. Their HCF is:
Ans 1. 98

2. 100

3. 108

4. 95

Q.76 According to the Press Information Bureau, by what percentage did India's Defence
Public Sector Undertakings (DPSUs) exports grow in the fiscal year 2024-25 compared
to the previous year?

Ans 1. 50.2%

2. 42.85%

3. 25.5%

4. 35.7%

Q.77 In which year did the English East India Company pass a new law that required every
new person who took up employment in the Company’s army to serve overseas if
required?

Ans 1. 1840

2. 1860

3. 1850

4. 1856

Q.78 In January 2025, who became the first Indian to be nominated for Best Director (Motion
Picture) at the Golden Globe Awards?

Ans 1. Meghna Gulzar

2. Zoya Akhtar

3. Payal Kapadia

4. Mira Nair

Q.79 Kanchan’s salary is ₹12,000 per month. He spends ₹4,000 on house rent and ₹2,000 on
bills, and the rest of the amount is his monthly savings. Find his savings (in ₹) in a year,
if in the month of his birthday, he spent all his monthly savings on birthday
celebrations.

Ans 1. 66,000

2. 60,000

3. 72,000

4. 54,000
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Q.80 P, Q, R, S, T, U and V have an exam on different days of the week starting on Monday
and ending on Sunday. Q has an exam on Friday. Exactly 3 people have an exam
between R and T, neither of whom has on exam on Sunday. P has an exam immediately
after U. V has an exam immediately before T. Who among the following has an exam on
Wednesday?

Ans 1. S

2. R

3. V

4. U

Q.81 The curved surface area of a cylinder is half of its total surface area. If its height is 195
cm, then find its diameter (in cm).

Ans 1. 393

2. 390

3. 383

4. 381

Q.82 QP 15 is related to TR 6 in a certain way. In the same way, KN 8 is related to NP −1. To
which of the given options is LO 3 related, following the same logic?

Ans 1. OP −9

2. BH −4

3. YR −7

4. OQ −6

Q.83 A factory produces 15, 20, 25, 10, and 30 units of a gadget over five days. What is the
average production (in units) per day?

Ans 1. 18

2. 20

3. 24

4. 22

Q.84 Which Delhi Sultanate ruler was associated with the expedition of Bhilsa (Vidisha) in AD
1292?

Ans 1. Iltutmish

2. Alauddin Khilji

3. Ghazi Malik

4. Ulugh Khan

Q.85 Who among the following was awarded the Grand Collar of the Timor-Leste in August
2024?

Ans 1. Narendra Modi

2. Droupadi Murmu

3. Om Birla

4. Dr. S Jaishankar

Q.86 Who inaugurated 'Srjanam', a biomedical waste conversion system, at AIIMS Delhi in
2025?

Ans 1. NITI Aayog Member

2. Director of AIIMS Delhi

3. Union Minister for Science and Technology

4. Director of CSIR-NIIST
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Q.87 Nilgiri Biosphere Reserve spans which of the following groups of Indian states?
Ans 1. Maharashtra, Goa, Karnataka

2. Kerala, Telangana, Tamil Nadu

3. Andhra Pradesh, Tamil Nadu, Kerala

4. Tamil Nadu, Kerala, Karnataka

Q.88 The Ministry of MSMEs in India celebrates the MSME Day on ______.
Ans 1. 7 June

2. 14 April

3. 27 June

4. 30 January

Q.89 Which aspect of life is explored under the theme of akam in Sangam literary works?
Ans 1. Deed

2. Politics

3. War

4. Love

Q.90

Ans 1. 

2. 

3. 

4. 

Q.91 According to a Morgan Stanley Report, how much is India’s infrastructure investment
expected to increase as a percentage of GDP by FY29?

Ans 1. 5.3%

2. 7.0%

3. 6.5%

4. 4.5%

Q.92 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) 3 # 6 5 2 @ 8 * 7 9 1 % 2 8 1 9 3 # 1 £ © 7 (Right)

How many such numbers are there each of which is immediately preceded by a number
and also immediately followed by a symbol?

Ans 1. 5

2. 3

3. 4

4. 2

Q.93 The endangered bird species found in the Thar Desert is:
Ans 1. Pelican

2. Hornbill

3. Flamingo

4. Great Indian Bustard
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Q.94 In a certain code language, ‘MEAN’ is coded as ‘6248’ and ‘AIDS’ is coded as ‘5721’.
What is the code for ‘A’ in the given code language?

Ans 1. 5

2. 7

3. 4

4. 2

Q.95 The ratio between the perimeter and breadth of a rectangle is 3 : 1. If the area of the
rectangle is 98 cm2, find the perimeter (in cm) of the rectangle.

Ans 1. 38

2. 50

3. 42

4. 47

Q.96 In February 2025, which international organisation signed a strategic partnership with
the African Union to boost vaccine manufacturing on the continent?

Ans 1. World Health Organization

2. International Monetary Fund

3. GAVI – The Vaccine Alliance

4. World Bank

Q.97 12 is related to 4 following a certain logic. Following the same logic, 24 is related to 8.
To which of the following is 60 related, following the same logic?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 – Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

Ans 1. 30

2. 15

3. 25

4. 20

Q.98 The mention of DNA as a long polymer of deoxyribonucleotides implies which structural
characteristic?

Ans 1. It is composed of a sugar-phosphate backbone and nitrogenous bases.

2. Each nucleotide is linked by hydrogen bonds in a parallel fashion.

3. The sequence is circular and self-replicating.

4. The molecule consists of multiple independent short chains.

Q.99 M is inversely proportional to N. If M is 18, then N is 21. If N = 27, then what is the value
of M?

Ans 1. 14

2. 12

3. 13

4. 16

Q.100 Akash sold an article at a loss of 21%. If he had bought the item at 8% less and had sold
it for ₹198 more, then he would have gained 5%. Find the cost price (in ₹) of the article.

Ans 1. 1,419

2. 686

3. 1,125

4. 685
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